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Abstract

The gram-negative bacterium Coxiella burnetii causes human Q fever, a disease characterized by a 

debilitating flu-like illness in acute cases and endocarditis in chronic patients. An obligate 

intracellular pathogen, Coxiella burnetii survives within a large, lysosome-like vacuole inside the 

host cell. A unique feature of the Coxiella parasitophorous vacuole (PV) is high levels of fusion 

with the host endocytic pathway, with PV-endosome fusion critical for Coxiella survival within the 

host cell. This unit describes quantitating PV-endosome fusion by measuring delivery of the fluid 

phase endosome marker dextran to the PV using live cell imaging. To study the effect of host cell 

proteins involved in PV-endosome fusion, details are provided for using siRNA knockdown host 

cells. This method is a powerful tool to understanding mechanisms underlying Coxiella’s ability to 

manipulate host cell trafficking pathways.
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Introduction

The Coxiella parasitophorous vacuole (PV) is known to be highly fusogenic with host 

vesicular trafficking pathways, including endosomes, lysosomes, and autophagosomes 

(reviewed in (Larson et al., 2016)). In epithelial cells such as HeLa cells, the bacteria 

initially reside in a small, tight-fitting vacuole. Around 24–48 hours, the PV expands, 

followed by bacterial replication. While the source of membrane during PV expansion has 

not been definitively determined, it is believed to occur through fusion with endocytic 

vesicles. Further, Coxiella actively manipulates endocytic trafficking by secreting effector 

proteins into the host cytosol through the Coxiella type IVb secretion system (T4BSS). 

When PV-endosome fusion is inhibited through either depletion of host proteins involved in 

fusion or a Coxiella T4BSS mutant, Coxiella growth is significantly inhibited.
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Given the importance of PV-endosome fusion during Coxiella’s intracellular growth, the 

ability to examine PV-endosome fusion is critical to further understanding the dynamics of 

this interaction. Fluorescent dextran is internalized by fluid-phase endocytosis and known to 

be delivered to the PV (Heinzen, Scidmore, Rockey, & Hackstadt, 1996). This unit describes 

a method for quantitating trafficking of fluorescent dextran to the PV using confocal live cell 

microscopy (Basic Protocol 1). Support Protocols 1 and 2 describe Coxiella infection of 

HeLa cells and replating onto optical grade chambered slides. Supporting Protocol 3 uses 

siRNA to knockdown host genes of interest. Support Protocol 4 describes setup and testing 

of the live cell chamber, with data analysis provided in Support Protocol 5.

BASIC PROTOCOL 1. Trafficking of Fluid Phase Marker to the CPV

The basic principle of this protocol is a classic pulse-chase, where a fluorescent fluid phase 

marker (fluorescent dextran) is internalized by Coxiella-infected cells through endocytosis. 

After a pre-set time (or pulse), the fluid phase marker is removed from the media and the 

dextran-positive endosomes traffic and fuse with the PV (chase). The increase in PV dextran 

fluorescence is measured during the chase. The effect of depletion or overexpression of 

proteins, drug treatment, or bacterial mutant on dextran delivery to the PV can be measured 

to demonstrate a role in PV-endosome fusion.

This protocol uses wild type Coxiella burnetii expressing mCherry red fluorescent protein 

(mCherry-Coxiella) and the HeLa epithelial cell line. If other cell types are used, pulse-

chase conditions may need to be determined empirically. When using Coxiella strains not 

expressing mCherry, alternative methods will be needed to identify PVs (e.g., phase 

microscopy). This protocol uses an automated Nikon microscope and Yokogawa spinning 

disk confocal, but other microscope platforms can also be used. A spinning disk confocal 

microscope is essential in order to minimize cellular toxicity that occurs with excessive 

illumination while enabling fast and efficient imaging. Further, confocal imaging minimizes 

fluorescence from outside the focal plane and improves accuracy. An automated stage is 

required to image multiple PVs per experiment.

Materials

60× 1.4 NA oil immersion objective (Cat# MRD01605) on a motorized and fully 

automated inverted microscope-motorized TiE controlled by Elements (Nikon 

Instruments, Melville, NY)

Andor iXon 887 EM-CCD attached to a CSU10 spinning disk confocal (Yokogawa, 

Japan) with a MLC-400 Agilent laser launch with 488 and 561 nm lasers (Agilent, 

CA) and Lambda 10-3 controlled filter wheel (Sutter Instruments, Novato, CA) fitted 

with emission filters ET525/36m and ET605/70m (Chroma Technologies, Bellows 

Falls, VT) attached to the above microscope.

Live cell chamber, humidified and equilibrated to 37.1°C, 5% CO2 (Support Protocol 

4).
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HeLa cells infected with mCherry-Coxiella and plated on Ibidi μ-Slides (Support 

Protocols 1 and 3). If desired, HeLa cells can be treated with siRNA (Support 

Protocol 2) prior to Coxiella infection.

Complete culture media (RPMI with 10% fetal bovine serum)

200 μL pipette and sterile tips

2 mg/ml Alexa488-labeled dextran (10,000 molecular weight; D22910, 

ThermoFisher Scientific) in culture media (see reagents).

1. Warm culture media and dextran in culture media to 37°C.

This is critical to avoid flexing of the plastic that occur with temperature 

fluctuations.

2. In one channel of the μ-Slide, use mCherry-Coxiella to identify PVs and mark 

positions using microscope software.

To maximize the number of imaged PVs and avoid issues with oil in 

moving between channels, only one channel should be imaged at a time.

3. Determine the timepoints for sampling, total chase time, z-sample (number of z-

stacks and size of slices), and camera settings (e.g., exposure time) for both 

Alexa488-dextran and mCherry-Coxiella. Setup the imaging experiment in the 

microscope software with the determined settings. In Elements, these setting are 

set within the “nd Acquisition” tool.

Set the timepoints to allow for the time it takes to collect the z-stacks at 

all the positions identified. Timepoints should be kept constant between 

experiments to facilitate comparisons.

Ideally, z-stacks will be sampled at or near the Nyquist criteria (~0.130 
μm for this 60× 1.4 NA oil immersion objective used here, https://svi.nl/

Nyquistcalculator). We typically sample at ~0.3 μm. Following the 
washes, the z-stack range and camera setting can be confirmed and 
adjusted as required as the dish may be move slightly during the 
washing steps.

In determining camera settings, it is imperative that there are no 

saturated pixels within the PV. If this happens, pixel intensities will be 

artificially cutoff and the mean intensities will be under-estimated.

4. With a 200 μL pipette, carefully remove 120 μL from the far channel. To the near 

channel, add 120 μL of pre-warmed (37°C) Alexa488-dextran (2 mg/ml in 

culture media) and simultaneously start a timer. Incubate for 10 minutes.

HeLa cells are cultured on the channel slides in 150 μL. Removing 120 

μL will leave 30 μL in the culturing channel. Be careful to not disturb 

the Ibidi slide.

5. After ten minutes, use a 200 μL pipette to remove 120 μL of the labeling media 

from the far reservoir. Add 120 μL of 37°C culture media to the near reservoir, 
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allow the media to reach the far reservoir and remove 120 μL from the far 

reservoir.

6. Repeat at least 4 more times.

Five washes should be sufficient to remove uninternalized Alexa488-

dextran. More washes may be performed if residual green fluorescence 

is observed in the extracellular media.

7. Check the PV positions, the z-stack range and the camera settings identified in 

step 1. Record this time as “dead-time.”

Typically, the ‘dead-time’ is 3–4 minutes. When comparing between 

experiments it is imperative that this is consistent to ensure comparable 

trafficking times.

8. Begin imaging experiment using the settings set in step 1 or as adjusted in step 7. 

The first set of captured images represents the “initial” intensity.

SUPPORT PROTOCOL 1. Infection of HeLa cells with Coxiella

Coxiella readily infects a wide range of cell types, including epithelial cells and 

macrophages. Once internalized by the host cell, Coxiella-containing phagosomes can 

undergo homotypic fusion. As it has not been established if vacuole maturation proceeds 

differently in cells infected with multiple bacteria, this protocol uses infection conditions 

that have been optimized for ~1 bacterium per cell, with 30–40% of the cells being infected. 

The infection conditions are determined empirically for each bacteria stock, cell type, and 

culture vessel being used. For basic culturing of HeLa cells, see Current Protocols in 

Microbiology Unit 11A.2, “Sphingolipid trafficking and purification in Chlamydia 
trachomatis-infected cells” (Elizabeth R. Moore, 2013). For preparation of Coxiella Nine 

Mile II (NMII) stocks from Vero cells, see Cockrell et al (Cockrell, Beare, Fischer, Howe, & 

Heinzen, 2008). These steps should be done in a biosafety cabinet with sterile reagents.

Materials

Trypsinized HeLa cells

Hemacytometer

Tissue culture scope with 10X objective

Complete growth medium (RPMI containing 10% FBS)

24 well tissue culture plate

Coxiella burnetii stock [Copy Editor: Please ask the author to clarify… Is this labeled 

with mCherry? If so, where can you obtain this? Or, if you have to label it yourself, 

how is that done? Furthermore, it seems that mCherry should be mentioned in the 

protocol introduction.]

Sterile 1X PBS (phosphate buffer saline)

Winfree and Gilk Page 4

Curr Protoc Microbiol. Author manuscript; available in PMC 2018 August 11.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



1. Count HeLa cells with hemacytometer (Appendix 4A) and dilute to 1×105 

cells/ml in complete growth medium. Add 500 μL cells per well of 24 well plate, 

for a final number of 5×104 cells per well. Let adhere 4–6 hours.

Unless over-trypsinized, HeLa cells should attach and spread out within 

4 hours. The cells can also be left overnight; however, cell growth must 

be considered when calculating the number of bacteria to use during the 

infection. This can be determined by trypsinizing and determining cell 

number in several extra wells right before the infection.

2. In complete growth medium in a sterile 15 ml conical, dilute Coxiella stock to 

4×107 bacteria/mL. The final number of bacteria being added is 200 per cell.

Vortex the bacteria stock well before removing an aliquot, making sure 

to look for clumps. After adding to growth medium, vortex for another 

30–60 seconds.

3. Remove media from well and replace with 250 μL of diluted bacteria.

Incubating in a smaller volume increases the efficiency of uptake.

4. Incubate at 37°C, 5% CO2 for 1 hour.

5. Wash wells extensively with sterile PBS.

Coxiella NMII bacteria are hydrophobic, and tend to stick to the plastic. 

To remove uninternalized bacteria, it may be necessary to wash with 15 

– 20 exchanges of PBS. To ensure that the cells do not dry out, wash 

wells one at a time, always leaving enough PBS to just cover the cells.

6. Replace with 500 μL complete growth media.

7. Incubate at 37°C, 5% CO2.

SUPPORT PROTOCOL 2: Transfection of HeLa cells with siRNA

Transfection is a method to deliver nucleic acids into cells, typically using a lipid carrier. 

During a “forward” transfection, cells are seeded onto plates and transfected with nucleic 

acid-lipid complexes the following day. A “reverse” transfection involves adding the nucleic 

acid-lipid complexes while the cells are being seeded. Reverse transfection not only saves 

time but also often increases knockdown efficiency. This protocol uses reverse transfection 

to deplete cells of the protein of interest using small-interfering RNA (siRNA) with 

Dharmacon Smartpool siRNA and Dharmafect transfection reagent (GE Healthcare). These 

steps should be done in a biosafety cabinet with sterile reagents.

Materials

Sterile 1.5 ml microcentrifuge tubes

Serum-free RPMI

Dharmafect 1 (GE Healthcare)

Control (e.g., non-targeting) and experimental siRNA at 20 μM stock concentration
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24 well tissue culture plate

Trypsin

T25 or T75 of HeLa cells, depending on the number of wells to be transfected

Hemacytometer

Tissue culture scope with 10X objective

Antibiotic-free complete growth medium (RPMI with 10% fetal bovine serum)

1. Make a master mix of diluted Dharmafect in a 1.5 ml microcentrifuge tube. For 

each well of a 24 well plate, add 0.62 μL Dharmafect to 130 μL serum-free 

RPMI.

Serum-free media is required to form siRNA-lipid complexes. To keep 

the lipid from sticking to the tube walls, pipet the Dharmafect directly 

into the media.

2. Add stock siRNA to diluted Dharmafect master mix to a final concentration of 

50 nM. For example, for each well add 1.6 μl stock siRNA (20 μM) to 130 μL 

diluted Dharmafect master mix. Vortex briefly to mix.

Make a mastermix of siRNA if doing multiple wells.

3. To each well of a 24 well plate, transfer 125 μL of siRNA-lipid mix.

4. Incubate siRNA-Dharmafect mix 30 minutes at room temperature.

5. While incubating, trypsinize HeLa cells, count with a hemacytometer, and dilute 

to 5×104 cells/ml in antibiotic-free complete growth media.

For best transfection efficiency, use cells in log-phase and less than 20 

passages. The use of antibiotics will decrease efficiency and may cause 

toxicity. For basic culturing of HeLa cells, see Current Protocols in 

Microbiology Unit 11A.2, “Sphingolipid trafficking and purification in 

Chlamydia trachomatis-infected cells” (Elizabeth R. Moore, 2013).

6. Following the 30 minute incubation of siRNA-lipid mix, add 500 μL of diluted 

cells to each well, pipetting up and down several times to mix.

7. Transfer cultures to a 37°C, 5% CO2 incubator for desired amount of time.

For each targeted protein, the amount of time required for efficient 

knockdown should be determined, along with how the long the 

knockdown lasts and if Coxiella infection affects knockdown stability. It 

may be necessary to transfect a second time to achieve knockdown. In 

this case, we typically re-transfect with siRNA after infection with 

Coxiella.
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SUPPORT PROTOCOL 3. Replating infected cells from 24 well plate onto 

ibidi μ-slides

Cells treated with siRNA and infected with Coxiella are replated onto imaging dishes 24 hrs 

before imaging. Slides or dishes from Ibidi (Fitchburg, WI) are used because of their: 1) low 

volume and surface area, meaning fewer cells and less dextran are required; 2) optical grade 

plastic that is amenable to cell attachment while being compatible with high resolution 

fluorescence microscopy; 3) standard slide size. Here we describe plating onto the Ibidi μ-

Slide VI0.1, which has six channels to facilitate multiple samples in one experiment. When 

using for the first time, consult the manufacturer’s product information sheet for tips on 

handling and culturing cells in Ibidi μ-Slides.

Materials

Infected HeLa cells in a 24 well plate from Supporting Protocol 1

Sterile 15 ml conical tubes

Complete growth medium (RPMI containing 10% FBS)

Trypsin

Swinging bucket centrifuge

Hemacytometer

Tissue culture scope with 10X objective

200 μL pipetter with sterile tips

μ-Slide VI0.1 (catalog number 80296, Ibidi, Fitchburg, WI)

1. Transfer 10 mL complete growth medium to a 15 mL conical tube.

2. Trypsinize cells in a single well with 150 μL trypsin, and transfer to the 15 mL 

conical tube with complete growth medium.

It is often necessary to pool multiple wells of a 24 well plate, depending 

on how many cells are needed to plate the desired number of channels. 

To concentrate cells for plating onto the Ibidi μ-slide, the cells most 

often need to be spun down. This is because the trypsin must be diluted 

with 5 volumes of 10% RPMI to inactivate enzymatic activity and avoid 

killing the cells.

3. Centrifuge 250xg for 5 min.

4. Carefully remove the media, and resuspend in a small volume of complete 

growth medium (<500 μL).

5. Count cells with hemacytometer, and adjust volume to 2–3×105 cells/ml with 

complete growth medium.

6. Add 30 μL of resuspended cells to one channel of ibidi μ-slide.
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Consult the manufacturer’s product information sheet for tips on plating 

and removing bubbles.

7. Place in incubator at 37°C, 5% CO2 for ~2 hours to allow the cells to adhere.

Because Ibidi μ-Slides exchange gas through the bottom, make sure to 

incubate according to the instructions.

8. After the cells have adhered, add 120 μL of 10% RPMI to each channel. Remove 

bubbles if necessary, and place back in the incubator.

SUPPORT PROTOCOL 4. Setup of live cell imaging chamber

The objective in live-cell microscopy is to maintain a tissue culture model, such as HeLa 

cells, in their normal growth conditions while conducting experiments that are best followed 

using microscopy. It is essential that the temperature be stable at 37.1°C, as membrane and 

cytoskeletal dynamics can change dramatically with temperature. Temperature (37.1°C), 

CO2 (5%) and humidity are controlled using commercially available chambers that can be 

adapted to a wide variety of microscope stages and culture dishes. This protocol describes 

imaging of Ibidi μ-Slides using a slide adapter installed in the stage top incubator Bold Line 

from OkoLabs (Burlingame, CA). The temperature in the OkoLab chamber is regulated 

either by its own temperature or by an auxiliary thermistor that can be placed inside the 

chamber in a dish filled with water or media. We choose to use the auxiliary thermistor 

approach as we find the temperature at the dish cannot be maintained at 37.1°C by setting 

just the chamber temperature. In addition, an objective heater set to 37.1°C ensures the 

sample is not cooled by a room temperature objective.

Materials

Okolab Bold Line universal stage top incubator with CO2 module, objective heater 

and OkoTouch for control (H301 Bold Line, OkoLabs, Burlingame, CA)

Distilled water

2 well Ph+ imaging dish (80296, Ibidi, Fitchburg, WI)

μSlide VI0.1 (80666, Ibidi, Fitchburg, WI)

Type 37 Oil immersion fluid (Type 37, Cargille Laboratories)

1. Fill the gas humidification chamber with distilled water.

This step may be common to live cell stage-top incubators. Distilled 

water, as opposed to pure water (i.e., Milli-Q) is used to avoid corrosion 

of the thermistor.

2. To image Ibidi μ-Slides, install the two-position slide adapter (2xGS-M) for the 

OkoLab chamber and install on microscope.

When using the OkoLab chamber, select the slide insert (2xGS-M) in 

the stage setup menu on the OkoTouch controller
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3. Place a 2 well Ph+ imaging dish filled with distilled water in the live cell 

chamber and thread the thermistor into one of the wells and under the inset 

plastic.

The cap for the 2 well Ph+ can be used to secure the thermistor in place. 

The distilled water may be preheated to accelerate the equilibration of 

the imaging chamber.

4. Install objective heater on 60× 1.4 NA oil immersion objective (MRD01605, 

Nikon Instruments, Melville, NY) and turn objective heater on and set to 37.1°C.

5. Place a μ-Slide VI0.1 with water in the chambers in the live cell chamber, and 

contact the objective with 37.1°C immersion oil (Type 37, Cargille Laboratories).

6. Run calibration routines for the temperature control. OkoLab touch provides 

access to calibration when selecting different control approaches or stage inserts 

under the “Settings” menu. Calibration may take 1–2 hours with the OkoLab 

Bold Line.

This step may be skipped if a recent calibration is valid for a given room 

temperature. We find it beneficial to work with building engineers to 

minimize room temperature fluctuations and ensure that appropriate 

cooling capacity is available in the room.

7. Set the humidity to 75% and temperature to 37.1°C and allow the chamber to 

equilibrate.

The temperature and humidity progress may be followed graphically on 

the OkoLab Touch and can take up to an hour.

SUPPORT PROTOCOL 5. Analysis of trafficking time course

The experimental data is analyzed using the open source imaging analysis software FIJI (4), 

and plotted with the graphing software Prism (GraphPad, San Diego, CA). The microscope 

software (i.e., Nikon Elements) records an annotated dataset with metadata that should be 

archived and backed-up for future reference. FIJI has the basic tools for quantitative analysis 

and can open most proprietary software formats via Bio-Formats (Linkert et al., 2010). As 

such, this protocol is relevant if data is collected on a platform other than Nikon Elements.

Materials

FIJI, Version 2.0.0-rc-59/1.51j with Java 8 installed for your computer platform 
(http://imagej.net/Downloads)

Digital datasets from microscope

Excel (Microsoft, Redmond, WA) or other spreadsheet software

Prism (GraphPad, San Diego, CA) or other graphing software

NOTE: This protocol is demonstrated in Video1.mp4.
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1. Open dataset in FIJI: “File” -> “Import” -> ”Bio-Formats” and in the “Bio-

Formats” interface select “HyperStack” from the “View stack with” option.

If the digital dataset contains many image datasets, such as multiple 

cells or stage positions, select each one you wish to open in the “Bio-

Formats” interface.

2. Separate the imaging channels: “Image” -> “Color” -> “Split Channels”.

3. Select the channel that contains the fluorescent dextran by clicking on the 

relevant window.

4. Perform a background subtraction: “Process” -> “Subtract Background…” with a 

radius of 50 pixels and process all images in stack when asked by the “Process 

Stack?” dialog window.

This pixel radius is a compromise between the smallest and largest PVs 

that may be encountered under these infection conditions at 3 days post 

infection. If the experiment is done at different times post-infection, 

when the PVs are significantly smaller or larger, this may need to be 

adjusted.

5. Sum all the z-stack slices: “Image” -> “Stacks” -> “Z-Project…” select “Sum 

Slices” and check “All time frames.”

Stacks are summed to avoid introducing unintended sampling bias 

which could be introduced by selecting a single z-slice.

6. Open “Analyze” -> “Set Measurements…” and select “Mean gray value”, 

“Area” and “Display Label”.

The Label field recorded in the “Results” table will include the 

timepoint following the final colon.

7. Move to the first timepoint by dragging the slider at the bottom of the image 

window all the way to the left. Open “Analyze” -> “Tools” and select “ROI 

Manager…”

8. Make a circle selection with a diameter of at least 20 pixels inside the Coxiella 
PV but preferably not overlapping Coxiella and add the circle selection to the 

“ROI Manager” by selecting “Add” in the “ROI Manager” window.

By adding the selection to the “ROI Manager” it can be recalled later by 

clicking on the selection in the “ROI Manager”, if the selection is 

removed accidentally. Further, a selection may be recalled from the 

“ROI Manager” on additional datasets to maintain consistency in the 

area measured.

9. Record the fluorescent intensity in the circle selection by pressing the ‘m’ key. 

This is the “Initial” average intensity.

NOTE: The PV may be labeled overnight with a spectrally non-

overlapping labeled dextran (e.g. Alexa647) to aid in selection of an 
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area inside the PV or the entire PV. The circle ROI should only need to 

be moved as the cell moves during the experiment.

10. Move to the next time point. Move circle selection to inside the PV (if required) 

and record the value by pressing the “m” key. Repeat for every time-point.

11. Copy the results from the FIJI “Results” table and paste into an Excel 

spreadsheet by using the right-click menu on the “Results” table or the “Edit” 

menu when selecting the “Results” table.

12. The fold change in intensity is calculated by dividing the average intensity 

(“mean gray value” at each timepoint by the “Initial” average intensity.

This assumes the volume of the PV does not change dramatically over 

the time course. If this a concern, the PV may be labeled overnight with 

a spectrally non-overlapping labeled dextran as mentioned above to 

enable measurement of the entire PV volume at every time-point.

13. Repeat for additional PVs and plot the fold change in Prism as column data for a 

given treatment condition. Statistical test such as t-test or ANOVA may be 

performed as appropriate.

REAGENTS AND SOLUTIONS

Dextran stock solution

Resuspend lyophilized Alexa488-dextran (D22910, ThermoFisher Scientific) at 10 mg/ml in 

sterile 1X PBS. Make 100 μl aliquots and store at −20°C, protected from light. To make the 

working stock immediately prior to live cell imaging, dilute to 2 mg/ml in 10% RPMI and 

vortex well. Centrifuge at 12,000xg for 2 minutes to pellet insoluble material. Transfer 

supernatant to a new sterile microcentrifuge tube.

COMMENTARY

Background Information

An obligate intracellular pathogen, Coxiella first targets alveolar macrophages during natural 

infection, but can infect a wide range of cells (Khavkin & Tabibzadeh, 1988; Stein et al., 

2005; Voth & Heinzen, 2007). Following phagocytosis by a host cell, the Coxiella-

containing phagosome matures through the endocytic pathway into an acidic and hydrolytic 

phagolysosome. Approximately 24–48 hours after host cell internalization, the Coxiella 
parasitophorous vacuole (PV) expands, forming a mature PV that is large, dynamic, and 

highly fusogenic with endosomes, lysosomes, and autophagosomes (Voth & Heinzen, 2007). 

Coxiella extensively modifies the PV through insertion of bacterial proteins into the 

phagosome membrane, as well as recruitment of host cell proteins. Host vesicular trafficking 

pathways are known to be manipulated by the Coxiella T4BSS, which secretes bacterial 

proteins across the PV membrane and into the host cytosol.

While interactions between the PV and host endocytic trafficking pathways are essential for 

PV formation, only recently have some of the host cell factors been identified and described. 
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The small GTPases Rab1b, Rab5, and Rab7 are found on the PV, with siRNA knockdowns 

or overexpression of dominant negatives preventing PV formation (Beron, Gutierrez, 

Rabinovitch, & Colombo, 2002; Campoy, Zoppino, & Colombo, 2011; McDonough et al., 

2013; Romano, Gutierrez, Beron, Rabinovitch, & Colombo, 2007). Depletion of clathrin or 

the clathrin-adaptor protein AP2 also blocks PV expansion (Larson, Beare, Howe, & 

Heinzen, 2013), and the lysosomal membrane proteins LAMP-1 and LAMP-2 increase the 

rate of endosome fusion (Schulze-Luehrmann et al., 2016). The endocytic SNARES 

syntaxin-17 and VAMP7 have also emerged as a critical component of PV formation 

(Campoy, Mansilla, & Colombo, 2013; McDonough et al., 2013).

Several approaches have been used to demonstrate heterotypic fusion between host vesicular 

trafficking pathways and the PV. The most common approach is measuring PV size, as the 

amount of fusion is thought to directly relate to formation and maintenance of the large PV 

(Larson et al., 2013; Romano et al., 2007). A second approach is determining the percentage 

of PVs with host vesicular markers, for example lysosomal cathepsin D (Romano et al., 

2007), assuming that these proteins are delivered directly through fusion. Both of these 

approaches are simple and do not require specialized techniques; however, changes in PV 

size or marker acquisition could be due to factors other than PV-endosome fusion.

A third method examines delivery of vesicular cargo into the PV lumen, which is a direct 

measure of fusion between the PV and cargo-carrying vesicles. Both fluorescent dextran and 

BSA are used as fluid-phase endosome markers (Campoy et al., 2013; Campoy et al., 2011; 

Justis et al., 2017; Mulye, Samanta, Winfree, Heinzen, & Gilk, 2017), while fluorescent 

heat-inactivated Staphylococcus aureus and latex beads mark phagosomes (Colonne et al., 

2016; Schulze-Luehrmann et al., 2016). Traditionally, cargo delivery to the PV has been 

quantitated by determining the percentage of cargo-positive PVs, and has been used almost 

exclusively in fixed cells. While straightforward, quantitation is based strictly on the 

presence or absence of the marker, and cannot account for variations in fusion. As a result, 

more subtle phenotypes can be easily missed. This protocol quantitates the change in PV 

dextran fluorescence over time using live cell imaging, providing a continuous measure of 

fusion. By sampling at regular intervals during the timecourse, this approach can also 

identify conditions where the rate of fusion may vary with time, even if the amount of fusion 

is of the same final magnitude. The major disadvantage of this approach is that it requires a 

sophisticated spinning disk confocal microscope platform with live cell capabilities. Further, 

technical precision is critical, as the assay is very sensitive to timing precision and 

consistency between experiments.

Critical Parameters

Working with Coxiella—Avirulent Coxiella Nine Mile II (NMII) must be handled at 

biosafety level 2 (BSL2). Aseptic technique is required, as antibiotics traditionally used in 

cell culture (e.g., penicillin, streptomycin) inhibit Coxiella growth. Historically, Coxiella 
stocks were prepared from aged cultures in Vero cells, which allows for isolation of the 

stable small cell variant (SCV) of Coxiella. Recently, the development of an axenic media 

allows for growth in the absence of host cells (Omsland, 2012). For experiments that only 

use wild-type bacteria or bacteria that do not have a growth phenotype in cells (e.g., Coxiella 
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expressing mCherry), we use Coxiella isolated from Vero cells infected for 28 days 

(Cockrell et al., 2008). We find the yield from Vero cells to be significantly higher than 

axenic media, enabling the same stock to be used for months to years. While Coxiella stocks 

stored at −80°C in 10% DMSO appear to be stable for multiple freeze/thaws, it is a good 

idea to make single-use aliquots to eliminate the possibility of viability loss.

Working with eukaryotic cells—HeLa cells should be handled at BSL2 level using 

aseptic techniques. As with all eukaryotic cells, it is critical that HeLa cells are cultured 

under conditions that maintain optimum health. For example, cells should be split every 2–3 

days, kept sub-confluent, and used for a limited number of passages (typically 20) as HeLa 

cells acquire genetic alterations the longer they are kept under continuous culture. Stocks 

and cultures should be checked regularly for mycoplasma infection. A sudden loss in 

transfection or knockdown efficiency can often be traced to the cell health.

Timing of live cell imaging—Live cell imaging experiments are often limited by the 

frequency with which imaging can be performed for a given number of fields or stage 

positions. It is imperative that the speed of the microscope and its peripherals is sufficient to 

accomplish the required imaging between the desired timepoints. This will often limit the 

number of fields or cells that can be imaged, and can require multiple experiments to image 

a statistically significant number of PVs. A strict measurement of pulse time and dead time 

is required to enable comparisons between experiments.

Anticipated Results

This assay has proven to be sensitive and precise. In HeLa cells over a 30 minute time 

course, we have measured up to a 2 fold change in fluorescence at 3 days post infection. 

Importantly, we found a statistically significant 20% change in fusion between control and 

experimental conditions, indicating this assay can be used to measure subtle changes in PV-

endosome fusion.

Time Considerations

The significant variables in total experimental time include siRNA knockdown and Coxiella 
infection. Our typical experiment, examining trafficking at 3 days post infection, is five days 

long: siRNA transfection at day 1, Coxiella infection at day 2, replating onto Ibidi μ-Slides 

on day 4, and live cell imaging on day 5. In every experimental run of the basic protocol, 

nine to ten PVs should be imaged. A single run will take approximately 45 minutes and thus 

over a half day, accounting for live-cell setup and equilibration, 40–60 PVs can be measured. 

With properly staggered infected cells, a complete set of three experiments, with controls 

and experimental conditions, can be completed within two weeks.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.

Winfree and Gilk Page 13

Curr Protoc Microbiol. Author manuscript; available in PMC 2018 August 11.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Acknowledgments

This work was supported by the American Heart Association (14SDG18420034) and National Institutes of Health 
(AI121786) to S.D.G.

LITERATURE CITED

Beron W, Gutierrez MG, Rabinovitch M, Colombo MI. Coxiella burnetii localizes in a Rab7-labeled 
compartment with autophagic characteristics. Infect Immun. 2002; 70(10):5816–5821. [PubMed: 
12228312] 

Campoy EM, Mansilla ME, Colombo MI. Endocytic SNAREs are involved in optimal Coxiella 
burnetii vacuole development. Cell Microbiol. 2013; 15(6):922–941. DOI: 10.1111/cmi.12087 
[PubMed: 23217169] 

Campoy EM, Zoppino FC, Colombo MI. The early secretory pathway contributes to the growth of the 
Coxiella-replicative niche. Infect Immun. 2011; 79(1):402–413. DOI: 10.1128/IAI.00688-10 
[PubMed: 20937765] 

Cockrell DC, Beare PA, Fischer ER, Howe D, Heinzen RA. A method for purifying obligate 
intracellular Coxiella burnetii that employs digitonin lysis of host cells. J Microbiol Methods. 2008; 
72(3):321–325. DOI: 10.1016/j.mimet.2007.12.015 [PubMed: 18242746] 

Colonne PM, Winchell CG, Graham JG, Onyilagha FI, MacDonald LJ, Doeppler HR, … Voth DE. 
Vasodilator-Stimulated Phosphoprotein Activity Is Required for Coxiella burnetii Growth in Human 
Macrophages. PLoS Pathog. 2016; 12(10):e1005915.doi: 10.1371/journal.ppat.1005915 [PubMed: 
27711191] 

Heinzen RA, Scidmore MA, Rockey DD, Hackstadt T. Differential interaction with endocytic and 
exocytic pathways distinguish parasitophorous vacuoles of Coxiella burnetii and Chlamydia 
trachomatis. Infect Immun. 1996; 64(3):796–809. [PubMed: 8641784] 

Justis AV, Hansen B, Beare PA, King KB, Heinzen RA, Gilk SD. Interactions between the Coxiella 
burnetii parasitophorous vacuole and the endoplasmic reticulum involve the host protein ORP1L. 
Cell Microbiol. 2017; 19(1)doi: 10.1111/cmi.12637

Khavkin T, Tabibzadeh SS. Histologic, immunofluorescence, and electron microscopic study of 
infectious process in mouse lung after intranasal challenge with Coxiella burnetii. Infect Immun. 
1988; 56(7):1792–1799. [PubMed: 3290107] 

Larson CL, Beare PA, Howe D, Heinzen RA. Coxiella burnetii effector protein subverts clathrin-
mediated vesicular trafficking for pathogen vacuole biogenesis. Proc Natl Acad Sci USA. 2013; 
110(49):E4770–4779. DOI: 10.1073/pnas.1309195110 [PubMed: 24248335] 

Larson CL, Martinez E, Beare PA, Jeffrey B, Heinzen RA, Bonazzi M. Right on Q: genetics begin to 
unravel Coxiella burnetii host cell interactions. Future Microbiol. 2016; 11:919–939. DOI: 
10.2217/fmb-2016-0044 [PubMed: 27418426] 

Linkert M, Rueden CT, Allan C, Burel JM, Moore W, Patterson A, … Swedlow JR. Metadata matters: 
access to image data in the real world. J Cell Biol. 2010; 189(5):777–782. DOI: 10.1083/jcb.
201004104 [PubMed: 20513764] 

McDonough JA, Newton HJ, Klum S, Swiss R, Agaisse H, Roy CR. Host pathways important for 
Coxiella burnetii infection revealed by genome-wide RNA interference screening. MBio. 2013; 
4(1):e00606–00612. DOI: 10.1128/mBio.00606-12 [PubMed: 23362322] 

Mulye M, Samanta D, Winfree S, Heinzen RA, Gilk SD. Elevated Cholesterol in the Coxiella burnetii 
Intracellular Niche Is Bacteriolytic. MBio. 2017; 8(1):e02313–02316. DOI: 10.1128/mBio.
02313-16 [PubMed: 28246364] 

Omsland A. Axenic growth of Coxiella burnetii. Adv Exp Med Biol. 2012; 984:215–229. DOI: 
10.1007/978-94-007-4315-1_11 [PubMed: 22711634] 

Romano PS, Gutierrez MG, Beron W, Rabinovitch M, Colombo MI. The autophagic pathway is 
actively modulated by phase II Coxiella burnetii to efficiently replicate in the host cell. Cell 
Microbiol. 2007; 9(4):891–909. DOI: 10.1111/j.1462-5822.2006.00838.x [PubMed: 17087732] 

Winfree and Gilk Page 14

Curr Protoc Microbiol. Author manuscript; available in PMC 2018 August 11.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



Schulze-Luehrmann J, Eckart RA, Olke M, Saftig P, Liebler-Tenorio E, Luhrmann A. LAMP proteins 
account for the maturation delay during the establishment of the Coxiella burnetii-containing 
vacuole. Cell Microbiol. 2016; 18(2):181–194. DOI: 10.1111/cmi.12494 [PubMed: 26249821] 

Stein A, Louveau C, Lepidi H, Ricci F, Baylac P, Davoust B, Raoult D. Q fever pneumonia: virulence 
of Coxiella burnetii pathovars in a murine model of aerosol infection. Infect Immun. 2005; 73(4):
2469–2477. DOI: 10.1128/IAI.73.4.2469-2477.2005 [PubMed: 15784593] 

Voth DE, Heinzen RA. Lounging in a lysosome: the intracellular lifestyle of Coxiella burnetii. Cell 
Microbiol. 2007; 9(4):829–840. DOI: 10.1111/j.1462-5822.2007.00901.x [PubMed: 17381428] 

Winfree and Gilk Page 15

Curr Protoc Microbiol. Author manuscript; available in PMC 2018 August 11.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript


	Abstract
	Introduction
	BASIC PROTOCOL 1. Trafficking of Fluid Phase Marker to the CPV
	Materials

	SUPPORT PROTOCOL 1. Infection of HeLa cells with Coxiella
	Materials

	SUPPORT PROTOCOL 2: Transfection of HeLa cells with siRNA
	Materials

	SUPPORT PROTOCOL 3. Replating infected cells from 24 well plate onto ibidi μ-slides
	Materials

	SUPPORT PROTOCOL 4. Setup of live cell imaging chamber
	Materials

	SUPPORT PROTOCOL 5. Analysis of trafficking time course
	Materials

	REAGENTS AND SOLUTIONS
	Dextran stock solution

	COMMENTARY
	Background Information
	Critical Parameters
	Working with Coxiella
	Working with eukaryotic cells
	Timing of live cell imaging

	Anticipated Results
	Time Considerations

	References

